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Introduction
Akkadian Site Builder™ is is a day 1 provisioning solution for Cisco Unified Communications Manager
(CUCM). It’s a provisioning solution capable of quickly deploying new sites or dial plan configurations in
CUCM.
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1. Requirements and Limitations
The following sections provide information about the requirements that your system must meet, and
limitations that apply when you install or upgrade Akkadian Site Builder.

1.1. Virtual Machine Requirements
Akkadian Site Builder is a Linux based Virtual Appliance supported on VMware ESXi.

Supported Versions of VMware vSphere ESXi = 5.0 U1, 5.1, 5.5, 6.0, and 6.5

The recommended server requirements for are:

vCPU vRAM vDISK vNIC

2 8 80 GB 1

• Applications servers are defined as configured applications servers in Provisioning Manager and are
not related to the number of servers with a cluster.

• Minimum of 2000 MHz reserved

1.2. Application Support
Provisioning Manager provides support for the following applications:

Application Versions

Cisco Unified Communications Manager 10.x – 12.x

Cisco Unity Connection 10.x – 12.x

1.3. Browser Support
Site Builder is supported using the following browsers:

• Microsoft Internet Explorer 11+
• Microsoft Edge 39+
• Mozilla Firefox 53+
• Chrome 50+
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1.4. Network Requirements
Akkadian Site Builder communicates on the following ports:

Traffic Port Direction

Application Web Access HTTPS:443 Inbound —> Provisioning Manager

Communication to Cisco
Communications Manager HTTPS:8443 Outbound Provisioning Manager —>

CUCM

Communication to Cisco Unity
Connection HTTPS:443 Outbound Provisioning Manager —>

CUCn

FTP between application and backup
server TCP Port 21 Outbound Provisioning Manager —>

SFTP Server

Secure FTP between application and
backup server TCP Port 22 Outbound Provisioning Manager —>

SFTP Server

SMTP to mail server TCP Port 25 Outbound Provisioning Manager —>
SMTP Server

LDAP TCP/UDP Ports 389/
3268

Outbound Provisioning Manager —>
LDAP Server

Network Time Protocol (NTP) UDP Port 123 Outbound Provisioning Manager —>
NTP Server
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2. Virtual Appliance Deployment
Akkadian Site Builder is deployed as a virtual appliance on VMware ESXi versions 5.x and above. The steps
below will help guide you through the process of deploying the virtual appliance; however, you should
understand VMware or contact your VMware administrator for assistance.

1. Download the latest akkadian Site Builder OVA to a location accessible by the vSphere client.
2. From the vSphere client select Deploy OVF Template from the File menu.

3. Select the OVA from computer or network location and click Next to continue.
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4. Review the License Agreement and click Next to continue.
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5. Specify the name and location for the VMware machine and click Next to continue.
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6. Specify the VMware Host / Cluster and click Next to continue.
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7. Specify a host within the cluster and click Next to continue.
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8. Specify the storage location for the virtual machine and click Next to continue.
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9. Select Thick Provision Lazy Zeroed and click Next to continue.
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10. Select the Destination Network for the virtual machine and click Next to continue.
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11. Verify the virtual machine settings. The initial OVA deploys with 2 vCPU and 8GB Memory. Depending
on your system requirements, you may need to adjust the virtual CPU and Memory settings.
Please refer to the virtual machine requirements to determine the appropriate settings for your
environment.

12. Click OK to complete the deployment.
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13. To adjust the virtual machine CPU and Memory, locate the newly deployed virtual machine in vCenter,
right click on the virtual machine and select Edit Settings.

14. On the Hardware tab, select CPU and adjust the setting to provide the required number of cores for
your environment.

15. After adjusting the CPU, click on Memory and adjust the settings to provide the required resources for
your environment. When completed, click OK to commit the changes.
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16. Power on the virtual machine and proceed.

17. Locate the virtual machine in vSphere and open a console.

18. When the server boot process is complete, the system will arrive at a login prompt. Login using:

Username – akkadianuser
Password – akkadianpassword

19. From the Akkadian Appliance Manager main menu, select option 1 to Configure Network.
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20. Select option 1 to configure the network setting.
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21. Select option 0 (“ens160”) from the network interface menu.

22. Follow the prompt to configure the network settings for your environment.
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23. Select option 7 from the network configuration menu to configure the hostname. It is recommended
the hostname is entered using the fully qualified domain name.

Example – servername.yourdomain.com
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24. Optionally you may configure the server time by selecting option 2 form the configure network menu.

25. It is recommended you change the default Akkadian Appliance Manager password by selecting option
5 (“Appliance Manager Settings”) from the main menu and then selecting “3” (“Change Appliance
Manager user Password”).

Akkadian Labs Akkadian Site Builder Admin Guide - 2

Page 19 of 79



26. When all configurations are complete, select “s” from the network configuration menu to save the
configuration and restart the network.

27. From the main menu, select Reboot Server to finalize the configuration.

28. When the system returns to the login prompt, the Akkadian Site Builder virtual appliance deployment
is complete and can be accessed by going to https://{Server IP or Name}/asb.

Akkadian Labs Akkadian Site Builder Admin Guide - 2

Page 20 of 79



3. Initial Configuration
After completing the installation, Akkadian Site Builder requires some basic configuration before you can
begin provisioning. Written documentation during the beta will be limited and instead will be provided using
videos.

Please view the following video to learn how to get started with the Akkadian Site Builder.

3.1 Logging in for the First Time
1. In a browser, navigate to HTTPS://{Server IP or NAME}/asb

2. Log in using the default credentials:

Username – SBAdmin
Password – SBAdmin123 (Case sensitive)

https://player.vimeo.com/video/287356714
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3.1.1 Changing the Default Password
It is highly recommended that you change the default SBAdmin password and set a valid email address for
password recovery.

1. Click on “System” to expand the menu. Then click on “Users:.
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1. Click on the SB Admin user to

Please ensure the SBAdmin email address is valid for a successful password recovery!!
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4. System Configuration

4.1 Application Servers
Application Servers are the targets for Site Builder Package deployment. Akkadian Site Builder currently
supports the following Cisco UC applications:

• Cisco Unified Communications Manager
• Cisco Unity Connection

This section will guide you through the process of configuring applications servers in Site Builder.

4.1.1 Cisco Unified Communication Manager
Akkadian Site Builder integrates into a CUCM cluster using the AXL Web Service, which is typically running
on the Publisher node.

This section will guide you through the process of preparing CUCM for integration and configuring CUCM as
an Application Server in Site Builder.

4.1.1.1 Preparing CUCM
Two items are required on Cisco Unified Communications Manager to allow access via the AXL API:

1. The Cisco AXL Web Service must be activated and started
2. An Application user with with required privileges

The Cisco AXL Web Service is disabled by default on some versions of Cisco Unified Communications
Manager. The service must be activated to enable AXL API access.

To activate the AXL Web Service:

1. Browse to the CUCM Serviceability page on https:///ccmservice
2. Tools > Service Activation
3. Select the Publisher node
4. Scroll down to Database and Admin Services
5. Check the box for Cisco AXL Web Service and click Save
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To create CUCM Application User:

1. From the Cisco Unified Communications Manager Administration Web page, select Application User
from the User Management menu, and then click Add New.

2. In the User ID field, enter a name for the account.
3. In the Password and Confirm Password fields, type a password for the new user and then click Save.
4. Navigate down the page to Permissions Information.
5. Click Add to Access Control Group and then click Find.
6. Select the following Groups:

• Standard TabSync User
• Click Add Selected
• Click Save

4.1.1.2 CUCM Integration
To add a Cisco Unified Communications Manager Application Server:

1. Select Application Servers from the System menu
2. On the menu, click Add
3. A drop-down list will appear below the Add button, select Application server
4. In the Application Server Type drop-down menu, choose CUCM
5. Complete the remaining required fields
6. Click Save
7. Repeat this process for additional CUCM integrations
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4.1.2 Cisco Unity Connection
Akkadian Site Builder integrates into a Unity Connection cluster using Representational State Transfer
(REST) application programming interfaces (APIs) that provide provisioning access.

This section will guide you through the process of preparing Unity Connection for integration and configuring
Unity Connection as an Application Server in Site Builder.

4.1.2.1 Preparing CUC
Akkadian Site Builder communicates with Cisco Unified Connection using the REST API. The built-in Cisco
Unity Connection application administrator account can be used for access, but for security purposes a
separate account should be created.

To configure a new user:

1. From the Cisco Unity Connection Web page, select Users from the User section, and then click Add
New

2. In the User Type drop-down menu, select “User Without Mailbox”
3. In the Based-on Template drop-down menu, select “administratortemplate”
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4. In the Alias field, type a username (Example – SBREST) and click Save
5. From the Edit Menu select Password Settings and uncheck “User Must Change at Next Sign-In”

and click Save
6. From the Edit Menu select Change Password.
7. In the Password and Confirm Password fields, type a password for the user and click Save.
8. From the Edit Menu select Roles.
9. Verify the user has the “System Administrator” under Assigned Roles

4.1.2.2 CUC Integration
To add a Cisco Unity Connection Application Server:

1. Select Application Servers from the System menu
2. On the menu, click Add
3. A drop-down list will appear below the Add button, select Application server
4. In the Application Server Type drop-down menu, choose CUC
5. Complete the remaining required fields
6. Click Save
7. Repeat this process for additional CUC integrations

The default CUC authentication rule expires passwords in 120 days. For service accounts,
we suggest password are set not to expire.*
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4.2 Service Groups
Service Groups group application servers into a logical container for provisioning. A Service Group could
contain a CUCM application server by itself, a CUC application server by itself or both. Once created,
Service Groups cannot be modified or deleted as they are tied to the license.

To add a Service Group:

1. Select Service Groups from the System menu
2. On the menu, click Add
3. A drop-down list will appear below the Add button, select Service Group
4. Enter the Service Group Name
5. At least one application server type must be selected

a. If appicable, select a CUCM application server
b. If appicable, select a Unity Connection application server

6. Click Save
7. Repeat this process for additional Service Groups
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4.3 Email Configuration
Email configuration is optional, but is required for several features, such as notifications and password
recovery.

To configure email:

1. Select Email Configuration from the System menu
2. Configure the required fields to connect to your email server
3. Click Save
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4.4 LDAP Agreements
LDAP configuration is optional, but is required for LDAP authentication.

Akkadian Site Builder supports creating multiple LDAP agreements in order to support multiple domains.

1. Select LDAP Agreements from the System menu
2. Click Add to create a new agreement
3. Enter the information for your LDAP configuration

Field Description

LDAP Config Name Enter a name to identify this specific LDAP configuration

Base Enter the LDAP search base

Server The LDAP server IP address or DNS name

Port* Enter the LDAP server port number

Username Enter the LDAP Username used to authenticate to the LDAP server

Password Enter the LDAP Password used to authenticate to the LDAP server

Username Bind Attribute Enter LDAP Attribute to bind to Username during authentication
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4. When complete, click Save

4.5 FTP Configuration
FTP configuration is optional, but is required for several features, such automatic backup and log archiving.

To configure FTP:

1. Select FTP Configuration from the System menu
2. On the menu, click Add
3. Configure the required fields to connect to your ftp server

Akkadian Site Builder supports connecting to Active Directory on ports 389 and 3268.*
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4. Click Save
5. Repeat the process to add additional FTP locations

4.6 Roles
Roles are used to provide users access to features by using routes. Each role can contain multiple routes.

The system contains four default roles:

Role Description

Admin Access to System routes only

Creator Access to Packages and Global Variables

Deployer Access to Deployments only

Full Access Access to all routes

The default roles can be modified or deleted or additional roles may be created.

To add additional roles:
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1. Select Roles from the System menu
2. On the menu, click Add
3. Configure the role name
4. Optionally provide a description for the role
5. Add one or more routes to the role
6. Click Save
7. Repeat the process to add additional roles

4.7 Users
Site builder supports adding one or more users depending on the license. Users can be assigned one or
more roles.

The system has one built-in user SBAdmin.

To add additional users:

Before creating LDAP authenticated users, an LDAP Agreement must be configured.*

Akkadian Labs Akkadian Site Builder Admin Guide - 2

Page 34 of 79



1. Select Users from the System menu
2. On the menu, click Add
3. Set the User Type drop-down menu to Local or LDAP

a. For Local authentication, the email address is required
b. For LDAP authentication, set the User Type to LDAP and select the LDAP Agreement

4. Configure the required fields
5. Add the Role(s) to assign permissions
6. Click Save
7. Repeat the process to add additional users

4.8 Audit Trail
The Audit Trail provides a list of all the user transactions that have been executed in Site Builder.

To view the Audit Trail:

1. Select Audit Trail from the System menu
2. User Global Search to locate a transaction
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4.9 Logs
Logs contained detailed information regarding all transactions in Site Builder and are critical for
troubleshooting.

The Audit Trail provides a list of all the user transactions that have been executed in Site Builder.

To view logs:

1. Select Logs from the System menu
2. User Global search to locate a specific log transaction
3. Click Download All Logs to collect all logs from the system
4. Click Download Current Logs to collect the logs from the last day
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4.10 Update
Site Builder updates can be applied manually or automatically. By default, the system is configured for
manual updates, which will download the update, but it will not be automatically applied. Automatic updates
will download and automatically apply the update. In order to download the update, both the manual and
automatic methods require the system to have Internet access, but updates can also be downloaded and
applied manually.

To configure the system for automatic updates:

1. Log into Site Builder with Admin privileges
2. Select Update from the System menu
3. Select the Automatic Updates option and click Save

To manually apply an update:

1. If necessary, download the update
2. Log into Site Builder with Admin privileges
3. Select Update from the System menu
4. In the Upload Update Bundle section, click Choose File
5. Select the update bundle
6. Click Upload to transfer the file to the sever
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7. Once the file has uploaded, click Update Now

4.11 Backup & Restore
The Backup and Restore section provides the ability to:

• Perform manual backups
• Schedule backups
• Restore backups
• Manage scheduled backups

To perform a manual backup:

1. Select Backup & Restore from the System menu
2. Click the Backup & Download button

To schedule a backup:

The system will be backed up and the file saved to your local computer*
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1. Select Backup & Restore from the System menu
2. Click the Schedule New Backup button
3. Complete the required fields
4. Click Save
5. Repeat the process to add additional scheduled backups

Managing scheduled backups:

1. Select Backup & Restore from the System menu
2. Select an existing backup schedule Schedule New Backup button

1. Click the Scheduled Backups Actions
2. Choose an action (Run Now, Enable, Disable or Delete)

Please note an FTP location must be configured before configuring a scheduled backup*

Please note the Scheduled Backups Actions button will remain disabled until you select
an existing backup schedule.*

Select multiple backup schedules to update more than one schedule.*
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To restore from backup:

1. Select Backup & Restore from the System menu
2. Click the Restore button
3. Click Choose File and select the appropriate backup file
4. Click *Restore Backup File *

4.12 Branding
Branding can be used to update Site Builder with your company name, logo and colors.

To enable branding:

1. Select Branding from the System menu
2. Configure the required fields
3. Click Save
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4.13 Security Certificates
Site Builder is deployed with a self-signed SSL certificate, but optionally can be configured with a certificate
from a private or public certificate authority.

Site Builder supports SSL certificates generated using its own private key or using an external private key.

Method 1 – Use Site Builder’s private key

1. Select Security Certificate from the System menu
2. Select the Generate Certificate Signing Request tab
3. Complete the Certificate Signing Request form

1. When complete, click Generate CSR
2. Download the CSR file
3. On your Certificate Authority, generate a certificate using the CSR

The common name must match the fully qualified domain name of the server.!
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1. Select the Upload SSL Certificate tab
2. Click Choose File to the right of SSL Certificate and upload the certificate generate by your

certificate authority

3. If the certificate was generated using a Public Certificate Authority, click Upload to complete the
process

4. If the certificate was generated using an Internal Certificate Authority, select the Use Internal
Certificate Authority (CA) check box

5. Upload the Root Certificate from your Internal CA
6. Click Upload to complete the process

Method 2 – Use an external private key

1. Select Security Certificate from the System menu
2. Select the Generate Certificate Signing Request tab
3. Complete the Certificate Signing Request form

Uploading a Private Key is not necessary as the certificate was generated using
Provisioning Manager’s private key*

Site Builder must be restarted for the changes to take affect. This can be done using the
Appliance Manager CLI or using VMWare tools.*
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1. When complete, click Generate CSR
2. Download the CSR file
3. On your Certificate Authority, generate a certificate using the downloaded CSR
4. Select the Upload SSL Certificate tab
5. Click Choose File to the right of SSL Certificate and upload the certificate generate by your

certificate authority
6. Click Choose File to the right of Private Key and upload the private key from your certificate

authority
7. If the certificate was generated using a Public Certificate Authority, click Upload to complete the

process
8. If the certificate was generated using an Internal Certificate Authority, select the Use Internal

Certificate Authority (CA) check box
9. Upload the Root Certificate from your Internal CA

10. Click Upload to complete the process

The common name must match the fully qualified domain name of the server.!
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5. Global Variables
Global Variables are used to provide placeholders in template and packages. At the time of deployment, the
user will be prompted to input data for each Global Variable in the package.

There are two types of Global Variables:

Default – captures provisioning data using a validated input field
List – creates drop-down list for selection at provision

To add Global Variables:

1. Select Global Variables from the left navigation menu
2. On the menu, click Add
3. Enter a global variable Name
4. Select the Global Variable Type
5. Optionally enter a global variable Description
6. If List type chosen, enter list data:

a. Enter a Value that will be used to populate this Global Variable if chosen
b. Enter a Display Name, which will act as a logical label for the value when the list is presented

7. Click Save

Configure the options above as described in the following table:

Field Name Description

Global Variable Type Default or List

Name Enter the variable name

Description Enter a description

Value Required
(Checkbox)

By default, Global Variables are optional fields. Check Value Required to make these
required fields.
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6. Packages
Packages are grouping of one more more provisioning templates. Packages can be used to deploy single
item or an entire site or dial plan withing Communications Manager.

Before you begin configuring packages, it is best to spend some time planning. There are a few things you
should think about before you begin the configuration process:

1. Does the package require Global Variables? If so, config the GVs first.
2. The template order matters! Creating the package in the right order makes things much easier. Site

Builder does try and handle much of the logic, but determining the dependencies first makes things
much easier. For example, when provisioning a Calling Search Space, each of the member Route
Partitions must exist before being added. CSSs have a dependency on Partitions. Therefore,
Partitions should be provisioned before CSSs.

This section will describe the process of adding, editing and deleting packages.
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6.1 Adding Packages
Packages are required for deployment in Site Builder. Packages can be used in single or bulk deployments.

To add a Package:

1. Select Packages from the left navigation menu
2. Click the button, +New
3. From the menu that appears below the +New button, choose Package
4. Enter the Package Name, CUCM Version and/or CUC Version

6.1.1 Adding CUCM Templates
1. Select the first Template from the list to add it to the Package

Note that packages are not backwards compatible with older Cisco Collaboration Systems
Releases (CSR), but can be deployed up to 3 major version forward. For example, if a
package is created for CUCM (or CUC) 10.x, it will be deploy-able on CUCM (or CUC)
10-12, but a version 12.5 package cannot be deployed on CUCM (or CUC) 11.5.

*
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2. Configure the selected Template

Input fields on templates can be populated with Global Variables or static text. In the
example below, we will be prompted for Pattern, Description & Partition at deployment, but
Digit Discard Instruction Name is statically configured to PreDot. Any data inputted must
match exactly to the data in CUCM.

*
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3. Click Add Template to add the Template to the package
4. Repeat this process to add additional Templates

6.1.2 Adding CUC Templates
Akkadian Site Builder™ supports the provisioning and/or editing of following Unity Connection objects:

• Non-administrator Users with/without Mailboxes
• User Templates
• Call Handlers
• Directory Handlers
• Interview Handlers
• Call Routing
• Message Aging Policy
• Unified Messaging
• Dial Plan
• Basic System Settings
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• Schedules
• Telephony Integrations

1. Select the first Template from the list to add it to the Package

2. Configure the Template

As of this writing, there is only one type of Akkadian Site Builder™ Template for Unity
Connection: CUC Custom XML Template.*

Input fields on templates can be populated with Global Variables or static text. In the
example below, the value for the XML parameter, “DisplayName,” was prefixed with the
contents of the highlighted Global Variable, “Customer”.
*
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3. Click Add Template to add the Template to the package
4. Repeat this process to add additional CUC Custom XML Templates

6.1.2.1 REST API
Cisco Unity Connection includes several Representational State Transfer (REST) application programming
interfaces (APIs) that provide provisioning, messaging, and telephony access to Connection. These APIs
provide the ability to integrate Connection features into existing enterprise-wide provisioning management
systems and messaging clients. The APIs are REST interfaces that standardize operations such as add,
delete, view, and modify. Akkadian Site Builder utilizes a subset of REST APIs called, Cisco Unity
Connection Provisioning Interface (CUPI) API, which provides access to the most commonly provisioned
data on Cisco Unity Connection systems: users, contacts, distribution lists, and call handlers.
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For more information on Cisco Unity Connection REST API and CUPI, please go to Cisco’s website. At the
time of writing, the document titled, Cisco Unity Connection Provisioning Interface (CUPI) API, contains
detailed descriptions of each of the provisioning APIs currently available, including input parameters and
troubleshooting guidance. This document can be found on cisco.com under:

Support > Product Support > Unified Communications > Cisco Unity Connection > Maintain and
Operate Guides > Cisco Unity Connection Provisioning Interface (CUPI) API

6.1.2.2 Nested Functions
Nested functions allow CUC Custom XML functions to obtain values for required data parameters through
separate queries that are executed before the main API call is made. For example, to provision a new User
Template in CUC, the Object ID of the phone system must be provided (within XML label,
MediaSwitchObjectId). Since the Phone System’s Object ID is both unknown and variable it must first be
queried, held in a local variable then applied to the MediaSwitchObjectId label as part of the main XML call.

The nested function calls and the variables in which their results will be held are executed in a section
above and separate from the main REST API call. The section is delimited by the strings, <--nested and
-->, each on separate lines.

Within the nested section each nested call and associated variable are defined in the format:

Variable = REST API function

For example, to query the data of the Phone System named, PhoneSystem, and store the result in a
variable called, phonesysQueryResults, the following nested call would be needed:

<--nested
phonesysQueryResults = vmrest/phonesystems?query=(DisplayName%20is%20PhoneSystem)
-->

Due to the complexity of writing custom XML calls, it is strongly recommended that one
possess a solid level of comfort with advanced programming languages. REST API in
particular.
*

Once again, it is recommended to have a good working knowledge of CUC REST API,
particularly Cisco Unity Provisioning Interface (CUPI). Nested functions use the CUPI
queries and result sets.
*
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The result set from the previous example will look similar to the following code block. As stated earlier, it will
be stored in its entirety in the variable, phonesysQueryResults.

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<PhoneSystems total="1">

<PhoneSystem>
<URI>/vmrest/phonesystems/37900370-4c0b-4733-97bf-3e411640407a</URI>
<ObjectId>37900370-4c0b-4733-97bf-3e411640407a</ObjectId>
<DisplayName>PhoneSystem</DisplayName>
<MwiAlwaysUpdate>false</MwiAlwaysUpdate>
<MwiPortMemory>false</MwiPortMemory>
<CcmAXLUser>ccmaxl</CcmAXLUser>
<CcmAXLPassword>xR/ls6fQAc+A1sYCPWeanA==</CcmAXLPassword>
<CallLoopSupervisedTransferDetect>true</CallLoopSupervisedTransferDetect>
<CallLoopForwardNotificationDetect>true</CallLoopForwardNotificationDetec

t>
<CallLoopDTMF>A</CallLoopDTMF>
<CallLoopGuardTimeMs>2500</CallLoopGuardTimeMs>
<PortCount>10</PortCount>
<EnablePhoneApplications>false</EnablePhoneApplications>
<DefaultTRaPSwitch>true</DefaultTRaPSwitch>
<MwiForceOff>false</MwiForceOff>
<RestrictDialUnconditional>false</RestrictDialUnconditional>
<RestrictDialScheduled>false</RestrictDialScheduled>
<RestrictDialStartTime>0</RestrictDialStartTime>
<RestrictDialEndTime>0</RestrictDialEndTime>
<CallLoopExtensionDetect>true</CallLoopExtensionDetect>
<AXLServerURI>/vmrest/phonesystems/37900370-4c0b-4733-97bf-3e411640407a/a

xlservers</AXLServerURI>
<PhoneSystemAssociationURI>/vmrest/phonesystems/37900370-4c0b-4733-97bf-3

e411640407a/phonesystemassociations</PhoneSystemAssociationURI>
</PhoneSystem>

</PhoneSystems>

From the result set above, only the contents of ObjectId are needed, which will need to be further queried
from the container variable. The value of ObjectId will be used in the User Template XML label,
MediaSwitchObjectId. The following notation method will be used to extract the specific value desired from
the nested result set:

|nested.NestedResultVariable._XMLPath_|

Using the example above, the XML label, MediaSwitchObjectId, will look like the following:

<MediaSwitchObjectId>|nested.phonesysQueryResults.PhoneSystems.ObjectId|</MediaSw

Spaces and any non-alphanumeric characters need to be replaced by their ASCII
hexadecimal equivalent preceded by the escape character, ‘%’. In the example above the
space character was replaced by “%20”.

!
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itchObjectId>

Following is an example of an XML call in Akkadian Site Builder to create a new User Template with the
alias, “voicemail-user-template.” Note that the Global Variable, Customer, is used within the DisplayName
field. As mentioned in the Global Variable section, the value of Customer will be prompted at provisioning
and will be inserted where the Customer placeholder is displayed.

Nested functions can also be used in URL End Points. For example, some URLs require Object IDs. The
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URL for adding a SIP Server to an existing Port Group is one such case. The illustration below
demonstrates how a nested query can be implemented in the URL End Point string.

6.1.3 Pre & Post Delay
Pre Delay and Post Delay are numeric entry fields that represent (in seconds) the amount of delay that
must be observed before (Pre Delay) or after (Post Delay) executing the Template.

Certain provisioning functions in CUPI actually take several seconds after executing a REST API call to
create a new object before they appear and can be queried in the database.

For example, when creating a new Port Group it can take up to 15 seconds before it is searchable in the
database. The Port Group’s Object ID is needed to associate SIP Servers. In this case, you would need to
implement a Post Delay on the Port Group create template and/or a Pre Delay on the first SIP Server
create template as illustrated below.
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6.1.4 Template Deployment Order
When deploying a Site Builder package it is important to be mindful of the order of operations. Some
templates will have dependencies on others that need to be deployed first. For example, a Calling Search
Space template would have dependencies on its member Route Partitions. Therefore, Route Partitions
would need to be deployed before Calling Search Spaces.

There are four different sort methods:

1. Default – The Template types will be deployed in the order that they appear in the Package.
2. Default + Priority – The Template types will be deployed in the order that they appear in the

Package. Additionally, the individual templates within the Template type container can be assigned a
numeric priority value. The higher the numeric value, the higher the priority. For example, a template
with priority 20 will be deployed before a template with priority 15, and so on. Templates without an
assigned priority value will be deployed first (before any templates with assigned priority values).

3. Template Type – The template types used in the package will be listed below Sort Method dropdown
list. Each of the types in the list can be dragged and dropped into the desired order.

4. Template Type + Priority – The template types used in the package will be listed below Sort Method
dropdown list. Each of the types in the list can be dragged and dropped into the desired order.
Additionally, the individual templates within the Template type container can be assigned a numeric
priority value. The higher the numeric value, the higher the priority. For example, a template with
priority 20 will be deployed before a template with priority 15, and so on. Templates without an
assigned priority value will be deployed first (before any templates with assigned priority values).
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6.1.5 Global Variable (GV) Display Order
Global Variables are an integral part of the Site Builder tool that allow the Packages to be reused with
minimal changes between uses. At deployment the Global Variables are presented to the user in a list to be
populated with actual values. The order in which the Global Variables are presented in the list can be
configured ahead of time by selecting the GV Display Order button within the Package. A window will pop
up with all of the referenced Global Variables within the Package. Use your mouse to drag and drop the
Global Variables into the desired order and click, Save.
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6.1.6 Set CUC Version
For packages that had been created in a previous version of Site Builder that did not have a CUC option the
CUC version can be added after the fact with with the Set CUC Version button.
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A new dialog box will pop up. Choose the desired CUC version from the dropdown list.

6.2 Editing Packages
To edit a Package:

1. Select Package from the left navigation menu
2. In the list, click on the package name
3. When the package opens, you can:

• Add additional templates to package
• Edit existing templates in package
• Delete existing templates from package

To add a template to an existing package:

1. Select the first Template from the list to add it to the Package
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2. Configure the selected Template

3. Click Add Template to add the Template to the package
4. Repeat this process to add additional Templates

Input fields on templates can be populated with Global Variables or static text. In the
example below, we will be prompted for Pattern, Description & Partition at deployment, but
Digit Discard Instruction Name is statically configured to PreDot. Any data inputted must
match exactly to the data in CUCM.

*
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To edit a template in an existing package:

1. In the package click on the template name

2. Update the desired fields
3. Scroll to the bottom of the template and click Save Template
4. Repeat this process of additional templates

To delete a template from an existing package:

1. In the package click on the template name

2. Scroll to the bottom of the template and click Delete Template
3. Repeat this process of additional templates

6.3 Deleting Packages
To edit a package:

1. Select Package from the left navigation menu
2. In the list, select the package
3. Click the Delete button
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6.4 Copying Packages
To copy a package:

1. Select Package from the left navigation menu
2. In the list, select the package
3. Click the Copy Package button

6.5 Exporting Packages
Packages can be exported and imported into other Site Builder systems.
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To export a package:

1. Select Package from the left navigation menu
2. In the list, click on the package name
3. Click the Export button

6.6 Folders
Folders can be used to logically group Packages and/or to assign specific access/execution permissions to
a group of Packages.

6.6.1 Adding New Folders
To add a Folder:

1. Select Packages from the left navigation menu
2. Click the button, +New
3. From the menu that appears below the +New button, choose Folder
4. In the Packages List, a new folder will appear with its name entry field highlighted. You may enter a

new folder name or continue to use the automatically generated name.
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6.6.2 Renaming Folders
To change a Folder’s name:

1. Select Packages from the left navigation menu
2. Click/check the checkbox to the left of the Folder of which you would like to change the name
3. Click the button, Folder Actions
4. From the menu that appears below the Folder Actions button, choose Rename
5. In the Rename Folder popup window, type the new folder name in the supplied entry field.
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6.6.3 Assigning Permissions
To assign permissions to a particular folder, simply right-click above the target folder in the Package list and
choose Folder Permissions from the menu.
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The Access dropdown list has four choices:

1. None

2. Private – Contents of the folder can only be viewed and/or deployed by the current user.
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3. Shared with everyone – All users can access and/or deploy the contents of the folder. The possible
Access Levels are Read-Only and Read/Write.

4. Shared with selected users – Only the selected users can access and/or deploy the contents of the
folder. The possible Access Levels are Read-Only and Read/Write.
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6.6.4 Adding and Removing Packages from
Folders
To add packages to a folder, simply drag and drop packages from the list onto the desired folder.
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To remove packages from a folder, drag the desired package from the list below the menu to any other
folder or to the base list and drop it.
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6.7 Bundles
Bundles can be use to fuse together multiple Akkadian Site Builder packages into a single unit that can be
deployed as one.

One possible use for Bundles is to piece together a set of smaller Site Builder packages into a single, all
encompassing job. This could allow you to create and maintain smaller, task-oriented (or Object Oriented)
jobs in separate packages that can be combined into larger jobs that include different combinations of tasks.

To add a new Bundle:

1. Select Packages from the left navigation menu
2. Select two (2) or more Packages from the list of packages
3. Click the button, +New
4. From the menu that appears below the +New button, choose Bundle
5. Enter the Bundle Name. The CUCM Version and/or CUC Version should already be populated.
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6. Click Save.
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7. Deployments
Deployments are used to deploy packages. Before running a deployment the following must be configured:

• Application Server
• Service Group
• Package

7.1 Running Deployments
To run a deployment

1. Select Deployments from the left navigation menu
2. On the menu, click Add
3. Select the Service Group for the deployment
4. Select the Package to deploy
5. Enter a Deployment Name
6. Optionally enter a Deployment Description
7. Click Begin

Deployments can be used to deploy a package once or in bulk.*
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8. Input the data for any Global Variables

9. Click Save & Continue
10. Review the setting and then click Deploy

11. The deployment will be submitted to the queue and then processed
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7.2 Running Bulk Deployments
To run a bulk deployment

1. Select Deployments from the left navigation menu
2. On the menu, click Add
3. Select the Service Group for the deployment
4. Select the Package to deploy
5. Enter a Deployment Name
6. Optionally enter a Deployment Description
7. Check the Bulk Deployment checkbox
8. Click Begin

9. Input the data for any Global Variables
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10. Click Save & Deploy
11. The deployment will be submitted to the queue and then processed

7.3 Rolling Back a Deployment
A deployment may be rolled back for any reason. The rollback will remove all data that was provisioned by
deployment.

To rollback a deployment:

1. Select Deployments from the left navigation menu
2. Select or search for the deployment in the list
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3. Click on the deployment name of view the details
4. Click the Rollback button to roll back the deployment
5. Confirm the rollback operation

Note that rollbacks are permanent and cannot be reversed.!
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